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Safety Summary
The following general safety precautions must be observed during all phases of operation 
of this instrument. Failure to comply with these precautions or with specific warnings or 
operating instructions in the product manuals violates safety standards of design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer's failure to comply with these requirements. Product manuals 
are provided with your instrument on CD-ROM and/or in printed form. Printed manuals 
are an option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type in your product number in the Search field at the top of the 
page.

General This product is a Safety Class 1 instrument (provided with a protective earth terminal). 
The protective features of this product may be impaired if it is used in a manner not 
specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per IEC 
60825-1.

Environment Conditions This instrument is intended for indoor use in an installation category II, pollution degree 2 
environment. It is designed to operate at a maximum relative humidity of 95% and at 
altitudes of up to 2000 meters.

Refer to the specifications tables for the ac mains voltage requirements and ambient 
operating temperature range.

Before Applying Power Verify that all safety precautions are taken. The power cable inlet of the instrument serves 
as a device to disconnect from the mains in case of hazard. The instrument must be 
positioned so that the operator can easily access the power cable inlet. When the 
instrument is rack mounted the rack must be provided with an easily accessible mains 
switch.

Ground the Instrument To minimize shock hazard, the instrument chassis and cover must be connected to an 
electrical protective earth ground. The instrument must be connected to the ac power 
mains through a grounded power cable, with the ground wire firmly connected to an 
electrical ground (safety ground) at the power outlet. Any interruption of the protective 
(grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Do Not Operate in an
Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made only by qualified personnel. 

Instruments that appear damaged or defective should be made inoperative and secured 
against unintended operation until they can be repaired by qualified service personnel.

http://www.keysight.com
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Compliance and Environmental Information

Table 1  Compliance and Environmental Information

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
www.keysight.com/environment/product/ for more information.
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1 Introduction
 

Documentation

N4391A Documentation

The documentation for the Keysight N4391A Optical Modulation Analyzer 
consists of

• The documentation for the Keysight Infiniium Digital Signal Analyzer.
This documentation is supplied with the digital signal analyzer, 
including extensive online help. Refer to it for using the digital signal 
analyzer for modulation measurements, or for configuring the digital 
signal analyzer.

• The documentation for the optical modulation analyzer and the 
software application.
This consists of 

• This booklet, which contains the information you need to get your 
Optical Modulation Analyzer running, and to perform a first 
measurement.

• The online help, which provides the instructions for use.

• The online help for the 89601B vector signal analysis software.

N4392A Documentation

The documentation for the Keysight N4392A Optical Modulation Analyzer 
consists of

• This booklet, which contains the information you need to get your 
Optical Modulation Analyzer running, and to perform a first 
measurement.

• The online help, which provides the instructions for use.

• The online help for the 89601B vector signal analysis software.

Instructions for use

For further information, please refer to the online help. 
You can refer to the online help for the Optical Modulation Analyzer by 
selecting “Help/Show OMA Help” in the 89600 VSA software interface.
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General Safety Considerations

This product has been designed and tested in accordance with the 
standards listed on the manufacturer’s Declaration of Conformity (see 
Declaration of Conformity on page 86), and has been supplied in a safe 
condition. The documentation contains information and warnings that 
must be followed by the user to ensure safe operation and to maintain the 
product in a safe condition.

Intended use

This instrument is intended to use in an office or laboratory environment, 
under the environmental conditions listed in the specifications.

Safety symbols

Instrument markings

The instruction manual symbol. The product is marked with 
this warning symbol when it is necessary for the user to refer 
to the instructions in the manual.

The laser radiation symbol. This warning symbol is marked on 
products which have a laser output.

The electrostatic discharge symbol. This warning symbol is 
marked on products which have components that can be 
damaged by an electrostatic discharge. 

CAUTION
The caution sign denotes a hazard. It calls attention to a procedure which, if 
not correctly performed or adhered to, could result in damage to or destruction 
of the product. Do not proceed beyond a caution sign until the indicated 
conditions are fully understood and met.

WARNING
The warning sign denotes a hazard. It calls attention to a procedure which, if not 
correctly performed or adhered to, could result in injury or loss of life. Do not 
proceed beyond a warning sign until the indicated conditions are fully 
understood and met.
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The recycling symbol indicates the general ease with which 
the instrument can be recycled.

The C-Tick mark is the certification mark of the Australian 
Communications Authority.

The CE mark is the conformity marking of the European 
Community.

The CSA mark is a the certification mark of the Canadian 
Standards Association.

The earthing symbol marks a connection that is connected, 
through the instrument, to the earth of the line power.

 

WARNING
If this product is not used as specified, the protection provided by the equipment 
could be impaired. This product must be used in a normal condition (in which all 
means for protection are intact) only.

WARNING
No operator serviceable parts inside. Refer servicing to qualified service 
personnel. To prevent electrical shock do not remove covers.

WARNING
This is a Safety Class 1 Product (provided with protective earth). The mains plug 
shall only be inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor inside or outside of the instrument 
is likely to make the instrument dangerous. Intentional interruption is prohibited.

WARNING
To prevent electrical shock, disconnect the instrument from mains before 
cleaning. Use a dry cloth or one slightly dampened with water to clean the 
external case parts. Do not attempt to clean internally.

WARNING
Using controls or adjustments or performing procedures other than those 
specified in the documentation supplied with your equipment can result in 
hazardous radiation exposure.
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CAUTION
This product complies with over-voltage Category II and Pollution Degree 2.

CAUTION
Ventilation requirements: When installing the product in a cabinet, the 
convection into and out of the product must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4 °C for every 100 watts dissipated in the cabinet. 
If the total power dissipated in the cabinet is greater than 800 watts, then forced 
convection must be used.

CAUTION
Install the instrument so that the power cords are readily identifiable and is 
easily reached by the operator. This is how the instruments are disconnected. 
They disconnect the mains circuit from the mains supply before other parts of 
the instrument. 

Alternatively, an externally installed switch or circuit breaker (which is readily 
identifiable and is easily reached by the operator) may be used as a 
disconnecting device.

CAUTION
Always use the three-prong AC power cords supplied with this instrument. 
Failure to ensure adequate earth grounding by not using these cords may cause 
instrument damage.

CAUTION
This instrument has autoranging line voltage input. Be sure the supply voltage is 
within the specified range.
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Initial Safety Information

The laser sources classified by this guide are classified as Class 1M 
according to IEC 60825-1 (2007).

All laser sources comply with 21 CFR 1040.10 except for deviations 
pursuant to Laser Notice No. 50, dated 2007-June-24.

Laser Safety

Laser class 1M label (not applied to the product)

Laser class 1M label

A sheet of laser safety labels is included. In order to meet the requirements 
of IEC 60825-1 we recommend that you stick the laser safety labels, in 
your language, onto a suitable location on the outside of the instrument 
where they are clearly visible to anyone using the instrument 
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N4391A Option 220

Laser wavelength range 1528 nm to 1630 nm

Laser Type Booster Optical Amplifier

Laser Class according to IEC 60825-1 1M

Maximum CW output power of the Optical Modulation Analyzer* †

* CW output power is defined as the highest possible optical output power that the laser
source can produce at the output connector

† For power levels at “LOInput” ¢ 20dBm

< 100 mW

Maximum permissable CW output power 163 mW

Numerical aperture 0.1

Beam waist diameter < 10mm

N4392A Options 
100+310 or  
110+310 or  
100+300+320 or  
110+300+320 or  
100+300+310+320 or  
110+300+310+320 

Options
100+300 or  
110+300 or  
100+300+310 or  
110+300+310 

Option 310

Max. CW output power* < 100 mW - (internal Laser only) -

Beam waist diameter < 10 µm - -

Numerical aperture 0.1 - -

Laser class according to IEC 
60825-1 (2001)

Class 1M Class 1 -

Max. permissible CW output 
power†

163 mW 10 mW -

* Max. CW output power is defined as the highest possible optical CW power that the laser source can
produce at its output.

† Max. permissible CW output power is defined as the highest optical power that is permitted within the
appropriate IEC laser class.



16 Keysight N4391A/N4392A Optical Modulation Analyzer, Getting Started

1 Introduction
 

 

Line power requirements

Line power connectors

In accordance with international safety standards, the instrument has a 
three-wire power cable. When connected to an appropriate AC power 
receptacle, this cable earths the instrument cabinet. The type of power 
cable shipped with each instrument depends on the country of destination.

WARNING
Please pay attention to the following laser safety warnings:

• Under no circumstances look into the end of an optical cable attached to the 
optical output when the device is operational. The laser radiation can 
seriously damage your eyesight.

• Do not enable the laser when there is no fiber attached to the optical output 
connector.

• The laser is enabled by the software. The laser is on when the green LED 
above the LO Output connector is lit.

• The use of the instruments, such as microscopes or spectacles, with this 
product will increase the hazard to your eyes.

• The laser module has built-in safety circuitry which will disable the optical 
output in the case of a fault condition.

• Refer servicing only to qualified and authorized personnel.

CAUTION
The Keysight N4391A Optical Modulation Analyzer complies with overvoltage 
category II and pollution degree 2. It can operate from the single-phase AC 
power source that supplies between 100 V and 240 V (max. voltage fluctuation 
10%) at a frequency in the range of 50 to 60 Hz. The maximum power 
consumption of the optical modulation analyzer is 40 VA (N4391A) or 375 VA 
(N4392A) with all options installed.

Please refer to the documentation for your digital signal analyzer for information 
on its line power requirements.
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Environmental Information

This product is intended for indoor use only.

This product complies with the WEEE Directive (2002/96/EC) marking 
requirements. The affixed label indicates that you must not discard this 
electrical/electronic product in domestic household waste. 

Product Category: With reference to the equipment types in the WEEE 
Directive Annex I, this product is classed as a "Monitoring and Control 
instrumentation" product.

Do not dispose in domestic household waste. 

To return unwanted products, contact your local Keysight office, or 

see www.keysight.com/environment/product/ for more information.

WARNING
To avoid the possibility of injury or death, you must observe the following 
precautions before switching on the instrument.

• Insert the power cable plug only into a socket outlet provided with a
protective earth contact. Do not use an extension cord without a protective
conductor. Using an extension cord without a protective conductor means
the instrument is not earthed.

• Do not interrupt the protective earth connection intentionally.
• Do not remove protective covers. Operating personnel must not remove

instrument covers. Component replacement and internal adjustments must
be made only by qualified service personnel.

• Instruments that appear damaged or defective should be made inoperative
and secured against unintended operation until they can be repaired by
qualified service personnel.

• Defective, damaged, or malfunctioning instruments must be returned to an
Keysight Technologies Service Center.

• Do not operate the instrument in the presence of flammable gases or fumes.
Operation of any electrical instrument in such an environment constitutes a
definite safety hazard.
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N4391A/N4392A Shipping Contents

Unpack your shipment.

• Inspect the shipping containers for damage.

• Inspect the instruments.

• Verify that you received the options and accessories that you ordered.

Keep the shipping containers and cushioning material until you have 
inspected the contents of the shipment for completeness and have 
checked the equipment mechanically and electrically.

N4391A Contents

Contents for all options

1x optical modulation analyzer N4391A

1 to 3x FC/APC connector interface (quantity depends on options 
ordered)

81000NI

1x language labels sheet 81645-44309

1x torque wrench, 8lb-in, 5/16 inch 8710-1765

1x wrench, open-end, 8mm, steel hard chrome finish 8710-2466

1x calibration certificate 9230-0333

1x wrist strap with cord 6-lg blue 9300-1405

1x China RoHS addendum for photonic test and measurment 
products 

9320-6654

1x UK6 report E5525-10285

1x Getting started guide for the N4391A N4391-90Axx

1x Safety-booklet 9320-6792

1x power cord (country dependent)

Contents for data acquisition

0 to 1x Scope including all standard accessories 
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Contents for option M33

Contents for options Z20, Z25, Z33

1x cable-assembly USB-plug A to B 4-COND 500 mm 8121-1695

8x screw, pan-head, Torx-T15, M3.5X0.6 8mm-long 0515-1402

3x screw, 90-deg-flat-head, Torx-T10, M3X0.5 10 mm-long 0515-2033

1x plate scope interface N4391-04106

1x adapter plate for scope type B N4391-04108

1x bracket rear for scope type B N4391-04109

2x bracket rear N4391-25073

1x RF cable kit for single scope setup type B N4391-61663

1x optical mouse, USB/PS2 1150-7799

1x 104 key standard keyboard with USB connector 1150-7896

1x stylus-pen, cushion grip 1150-7997

1x cable, calibration 54916-61626

1x cable-Assembly USB-Plug A TO B 4-COND 500mm 8121-1695

1x connector saver collars kit of 10 54916-60003

1x connector Assembly- 3.5mm female to female-kit of 5 54916-68717

1x quick start guide (English) 54932-92000

1x software/firmware addendum 5190-1894

1x China RoHS addendum for oscilloscope 9320-6678

8x screw, pan-head, Torx-T15, M3.5X0.6 8mm-long 0515-1402

3x 90-deg-flat-head, Torx-T10, M3X0.5 10mm-long 0515-2033

1x plate scope interface N4391-04106

1x adapter plate for scope type B N4391-04108
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Contents of the RF cable kit for single scope setup (N4391-61663)

Refer also to the contents list of the digital signal analyzer.

If anything is missing or defective, contact your nearest Keysight 
Technologies sales office. If the shipment was damaged, contact the 
carrier, then contact the nearest Keysight Technologies sales office.

1x bracket rear for scope type B N4391-04109

2x bracket rear N4391-25073

1x RF cable kit for single scope setup type B (content see below) N4391-61663

1x RF cable, receiver to scope 1 port 1 N4391-61641

1x RF cable receiver to scope 1 port 2 N4391-61642

1x RF cable receiver to scope 1 port 3 N4391-61643

1x RF cable receiver to scope 1 port 4 N4391-61644
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N4392A Contents

Contents for all options

Contents for option 310

1x Optical Modulation Analyzer N4392A

1x Optical Mouse USB PS2 102 1150-7799

1x Mini Keyboard 319x157x20mm 0960-2929

0 to 4x 81000NI FC/APC connector interface (quantity depends on 
options ordered)

08154-61723

1x language labels sheet 81645-44309

1x calibration certificate 9230-0333

1x wrist strap with cord 6-lg blue 9300-1405

1x STYLUS-PEN Cushion Grip 5.54-in-LG 0.44-in-DIA 1150-7997 

1x RoHS addendum for photonic test and measurment 
products

9320-6654

1x UK6 report E5525-10285

1x Getting started guide N4392-90Axx

1x Safety-booklet 9320-6792

1x power cord (country dependent)

1x Entitlement certificate Basic N4392A software package N4392-90100

1x torque wrench, 8lb- in, 5/16 inch 8710- 1765 

1x wrench, open- end, 8mm, steel hard chrome finish 8710- 2466
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Depending on the options you order, you should also receive.

If anything is missing or defective, contact your nearest Keysight 
Technologies sales office. If the shipment was damaged, contact the 
carrier, then contact the nearest Keysight Technologies sales office.

1x Entitlement certificate option N4392A-410 N4392-90101

1x Entitlement certificate option N4392A-420 N4392-90103

1x Entitlement certificate option N4392A-430 N4392-90104
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Mounting an Infiniium 90000 Z-Series High-Performance Oscilloscope (option #M33, 
#Z20, #Z25, #Z33) on the Optical Test Set

If you do not have one of these options, please proceed to the next section.

1 Prepare the optical coherence receiver. 

a Using a Torx T15 screwdriver, loosen the screws holding the side 
panels on the optical coherence receiver. 

b Slide the side panels half-way to the rear. 

c Using a Torx T15 screwdriver, mount the scope interface plate 
(N4391- 04106) on the top front side of the optical coherence 
receiver. 

d Slide the side panels of the optical coherence receiver back into 
place and secure with captive screws.

e Remove the rear feet from the optical coherence receiver using a 
Torx T15. 



Keysight N4391A/N4392A Optical Modulation Analyzer, Getting Started 25

Getting Started 2

 

f Place the rear bracket (N4391- 04109) on the top rear side of the 
optical coherence receiver. 

g Using the screws from the rear feet (N4391- 25073), secure rear feet 
and rear bracket to the rear of the optical coherence receiver. 

2 Prepare the oscilloscope. 

a Place the oscilloscope upside down, and lay it on its top on the work 
surface. 

b Remove the 4 feet from the bottom of the oscilloscope.

c Using a Torx T10 screwdriver, mount the adapter plate (N4391- 
04108) on the bottom of the oscilloscope and secure using longer 
screws (0515- 2033) supplied.
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3 With the oscilloscope still on its top, mount the optical coherence 
receiver. 

a Remove the four screws on the bottom rear edge of the 
oscilloscope. This is where the rear bracket on the optical coherence 
receiver will be secured to the oscilloscope. 

b With the optical coherence receiver upside down, lock it onto the 
adapter plate. Ensure that the adapter plate locking tabs slide into 
the slots in the scope interface plate. 
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c Using a Torx T10 screwdriver and the screws from the oscilloscope, 
secure the rear bracket of the optical coherence receiver to the rear 
of the oscilloscope. 

4 Turn the assembly the right way up.
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5 Using the torque wrench supplied with the optical coherence receiver 
(part number 8710-1765) and the cables from the cable set (part 
number N4391-61663), connect the RF cables.

a Connect RF cable N4391- 61641 from Port 1 of the optical 
coherence receiver to Port 1 of the oscilloscope.

b Connect RF cable N4391- 61642 from Port 2 of the optical 
coherence receiver to Port 2 of the oscilloscope.

c Connect RF cable N4391- 61643 from Port 3 of the optical 
coherence receiver to Port 3 of the oscilloscope.

d Connect RF cable N4391- 61644 from Port 4 of the optical 
coherence receiver to Port 4 of the oscilloscope.
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Concluding the setup for all options

1 At the rear of the instrument, 

a Connect the mouse and keyboard to the digital signal analyzer.

b Using the USB cable supplied, connect the optical modulation 
analyzer to the digital signal analyzer.

c Using the two power cables supplied, connect the power cables to 
the digital signal analyzer (the power socket with the notch), and the 
optical coherent analyzer.

d If necessary, connect your LAN cable to the digital signal analyzer.

2 At the front of the instrument, put the electrostatic discharge band 
around you wrist, and plug it into the earthed connector at the bottom 
right of the instrument.

3 Working from one side to the other (left to right or right to left), attach 
the rigid cables between the digital signal analyzer and the optical 
modulation analyzer.
Note: you may find this easier if you move the front of the instrument 
so it is at the front edge of the table or bench you are working on.

a Remove the protective cap from the signal input on the optical 
modulation analyzer.

b Make sure you have the rigid cable with the same number as the 
connector on the digital signal analyzer.

c Remove the protective cap from the smaller connector on the rigid 
cable.

d Connect the BNC connector to the digital signal analyzer.
Tighten the connector until it is finger tight.

e Connect the rigid cable to the connector on the optical modulation 
analyzer.

f Using the spanner wrench supplied, holding the end of the rigid 
cable, and use the torque wrench supplied to tighten the connector.

NOTE
The connectors on the optical modulation analyzer tighten anti-clockwise.



30 Keysight N4391A/N4392A Optical Modulation Analyzer, Getting Started

2 Getting Started
 4 Remove the protective covers from the connector interfaces on the 

front of the instrument and from the patchcord connectors. 

5 Connect the optical patchcord. 

6 Turn on the instrument, by pressing the power button at the lower left 
corner of the front panel.

Using the correct connectors

CAUTION
Always use patchcords to connect to your DUT. This protects the connectors of 
the optical modulation analyzer, by minimizing the number of connector 
changes.

CAUTION
The contact connector on the optical modulation analyzer is angled. If you are 
using a patchcord with straight and angled connectors, make sure you connect 
the angled connector to the optical modulation analyzer.
Connecting to the optical modulation analyzer with a straight connector will 
damage it.

CAUTION
Before you connect any fiber-optic cable to the Optical Modulation Analyzer, 
please ensure it has been properly cleaned.
Fiber-optic connectors are easily damaged when connected to dirty or damaged 
cables and accessories. When you use improper cleaning and handling 
techniques, you risk expensive instrument repairs, damaged cables, and 
compromised measurements. 

CAUTION
Always use patchcords to connect to your DUT. This protects the connectors of 
the optical modulation analyzer, by minimizing the number of connector 
changes.

CAUTION
The contact connector on the optical modulation analyzer is angled. If you are 
using a patchcord with straight and angled connectors, make sure you connect 
the angled connector to the optical modulation analyzer.
Connecting to the optical modulation analyzer with a straight connector will 
damage it.
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Using the patchcords also keeps service costs down, as the adaptor 
patchcord can be exchanged easily.

Angled contact connectors have up to 30dB higher return loss than 
straight connectors, and we recommend them for best performance 
results. With angled fiber endfaces, reflected light tends to reflect into the 
cladding, reducing the amount of light that reflects back to the source.

Enabling and disabling the laser output

After the Optical Modulation Analyzer application running on the digital 
signal analyzer has initialized it, the green LED above the laser output 
indicates whether the laser is emitting radiation.

The laser is enabled and disabled by the software.

If the Laser output is on, the green LED on the front panel of the module is 
lit. If the Laser output is off, the green LED on the front panel of the 
module is not lit.

CAUTION
Before you connect any fiber-optic cable to the Optical Modulation Analyzer, 
please ensure it has been properly cleaned.
Fiber-optic connectors are easily damaged when connected to dirty or damaged 
cables and accessories. When you use improper cleaning and handling 
techniques, you risk expensive instrument repairs, damaged cables, and 
compromised measurements. 
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Creating Your First Trace on the OMA

The following procedure will familiarize you with the OMA by loading a 
recorded demo then using the Smart Setup dialog to ensure that the 
parameters are set properly.

The recorded demo is a PRBS 15 dual polarization signal with a 
performance that is typically achieved on optical coherent long-haul 
transmitters. This signal has incorporated bit errors inserted into the 
transmitter PRBS generation.

1 Power on the equipment.

2 Start the Keysight 89600 VSA Software interface by double-clicking on 

the Keysight OMA icon ( ).

3 In the Keysight 89600 VSA Software interface, select 
File > Recall > Recall Demo.

4 In the Recall Demo dialog, open the \Optical Signals\Generic\
DP-QPSK_10.12 GHz_with_errors.htm file.

5 Select the Smart Setup menu.
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6 Ensure that the Center Symbol Rate is set to 10 GHz. If not, 
double-click in the Center Symbol Rate field then enter the value. The 
Fine-tune symbol Rate selection ensures that the symbol rate is 
adjusted to within the displayed range.

7 Ensure that the Modulation Format is set to QPSK. If not, select it from 
the Modulation Format list.

8 Ensure that Polarization is set to Auto. If not, select it from the 
Polarization list. Smart Setup will determine the polarization 
automatically (single or dual) when set to Auto.
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9 Ensure that Compensate CD (chromatic dispersion) and Compensate 
PMD (polarization mode dispersion) are deselected.

10 Ensure that Use default screen layout is selected to use the default 
layout which provides a wide variety of results. If not selected, the 
current layout will be used.

11 Click on the OK button.

12 Select the Restart button ( ) in the tool bar to start the 
measurement.

13 You should see results similar to the following.
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How to Reconfigure Your N4391A Hardware

A standard setup according to ordered options is configured at the factory. 
This section shows how to modify the N4391A standard factory 
configuration.

1 In the Keysight 89600 VSA Software interface, select Utilities > 
Hardware > Discovered Instruments to view the list of the available 
instruments found by the software. A screen similar to the following is 
displayed.

2 Click on the Configurations tab.
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3 Click on the plus ( ) button.

4 From the Possible Logical Instruments list, select Keysight N4391A 
Optical Modulation Analyzer (based on the type of OMA) then click on 

the  button to add it to the Configuration list.
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5 In the ADC selection, click on the down arrow and select the 
oscilloscope configured with the N4391A.
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6 In the Downconverter selection, click on the down arrow and select 
the N4391A.



40 Keysight N4391A/N4392A Optical Modulation Analyzer, Getting Started

2 Getting Started
 

7 In the Synthesizer selection, click on the down arrow and select the LO 
configuration (internal or external LO).
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 8 In the name field, enter the desired name for this configuration then 
click on the OK button.

9 Repeat this procedure to add more configurations.

10 Select Input > Channels > Custom and review the channel mapping 
from the physical hardware input ports to the VSA measurement 
channel inputs.
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11 Select Input > Extensions and review the measurement hardware input 
extension parameters. The Extensions tab shows which logical 
instrument is currently active, and shows the available hardware 
extension parameters for the selected logical instrument (front-end 
hardware configuration).
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How to Reconfigure Your N4392A Hardware

A standard setup according to ordered options is configured at the factory. 
This section shows how to modify the N4392A standard factory 
configuration.

1 In the Keysight 89600 VSA Software interface, select Utilities > 
Hardware > Discovered Instruments to view the list of the available 
instruments found by the software. A screen similar to the following is 
displayed.

2 Click on the Configurations tab.
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3 Click on the plus ( ) button.

4 From the Possible Logical Instruments list, select Keysight N4392A 
Optical Modulation Analyzer (based on the type of OMA) then click on 

the  button to add it to the Configuration list.
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5 In the ADC selection, click on the down arrow and select the 
instrument and input configuration (electrical or optical).
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6 In the Synthesizer selection, click on the down arrow and select the LO 
configuration (internal or external LO).
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 7 In the name field, enter the desired name for this configuration then 
click on the OK button.

8 Repeat this procedure to add more configurations.

9 Select Input > Channels > Custom and review the channel mapping 
from the physical hardware input ports to the VSA measurement 
channel inputs.
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10 Select Input > Extensions and review the measurement hardware input 
extension parameters. The Extensions tab shows which logical 
instrument is currently active, and shows the available hardware 
extension parameters for the selected logical instrument (front-end 
hardware configuration).
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Installing Software Components

All software components are pre-installed at the factory. However, this 
section provides installation instructions if it becomes necessary to 
reinstall some or all of the software components. 

You can search for updates through the VSA interface by selecting Help > 
About OMA then clicking on the Check for updates button. Refer to the 
following screen.
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Downloading the Photonic Application Suite Package Manager

The Photonic Application Suite (PAS) Package Manager is used to select 
and download software packages for proper operation of the OMA. 

1 Visit the PAS Package Manager web page at 
www.keysight.com/find/N7700A, click on the Technical Support link, 
select the Drivers, Firmware & Software tab, then click on the 
Download button to start the download process.

2 Click on the Open button to open the zip file.
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3 Double-click on the executable file to run the PAS Package Manager.

4 Start the PAS Package Manager as administrator and select the OMA 
tab to see all possible OMA packages.
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Installing the Keysight N439xA Software

1 Select the “Keysight N439x Processing Extensions” package which 
matches your licensed version. 

2 Click on the Download link.

3 Continue following the installation instructions and always select the 
default settings. The PAS Package Manager will install drivers and 
software which are required to install the OMA software. During the 
OMA installation itself select your installation type. You can postpone 
system restarts until the complete installation is finished.

4 After all installations have been finished, verify that the PAS Package 
Manager lists them with an “Installed Version”. If the installations are 
not listed, launch the installation of the missing package again. Likely 
it was interrupted by a system restart.
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N4391A Performance Verification

Refer to the topic called “N4391A Performance Verification” in the OMA 
Help for the performance verification procedure.

N4392A Performance Verification

Refer to the topic called “OMA Calibration” in the OMA Help for the 
performance verification procedure. Selecting Utilities > OMA Calibration 
in the VSA software interface opens the dialog for performing N4392A 
verification.

Returning the Instrument

If the performance verification fails and you cannot correct the problem, 
return the N4391A/N4392A to Keysight for repair following the steps 
shown below:

1 Record all symptoms.

2 Contact Keysight at http://www.keysight.com/find/assist. 

3 Use the original packing material or comparable packing material to 
ship the instrument to Keysight.

NOTE
The N4391A optical modulation analyzer and the digital signal analyzer are two 
parts of one instrument.

If you are returning the N4391A to Keysight support, you must return the full 
instrument, consisting of both parts.
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Rack Mounting N4391A Z-Series Oscilloscopes   /  58
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Rack Mounting N4391A Z-Series Oscilloscopes

1 Prepare the optical modulation analyzer for rack mounting.

a Remove the four feet from the bottom of the optical modulation 
analyzer. 

b At the front of the optical modulation analyzer, remove the covering 
strips at the left and right edges of the front panel.

c Using parts from the rack mount kit (part number 5063-9214), 
mount a rack flange at the left and right of the optical test head. 
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2 Using a Torx T25 screwdriver, mount the rails in the rack.
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3 Mount the optical modulation analyzer in the rack.

a Slide the optical modulation analyzer onto the rails in the rack.

b Using a cross-recess Phillips screwdriver, and the screws from the 
rack mount kit (screw part number 0570-1577), screw the flanges at 
the left and right of the optical modulation analyzer to the rack.

4 Mount the oscilloscope in the rack according to the procedure in the 
90000 Z-Series Oscilloscope Rack Mount Kit Installation Guide 
(N2759-93101). Mount the oscilloscope directly above the optical 
modulation analyzer.
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5 Identify 7U of rack space for instrument. 
Snap on sheet metal fasteners 0590-0804 in the eight locations 
shown.
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6 Attach rails to rack.
Attach rails N2759-03702 as shown using four of the #10-32 flathead 
fasteners 2510-0283. Ends marked “front” must be aligned as shown 
towards the front of the rack.



Keysight N4391A/N4392A Optical Modulation Analyzer, Getting Started 63

Rack Mount 4

 

7 Remove handles and bottom feet from the instrument.
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8 Attach rails to instrument.
Attach rails N2759-03701 to the instrument’s top handle holes using 
four of the screws from Step 7.
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9 Slide the instrument into the rack as shown. The instrument will stop 
when it reaches the proper depth.

CAUTION
Two people are required to lift the instrument.
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10 Secure the rear of the instrument as shown using two of the #10-32 
flathead fasteners 2510-0283.
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11 Attach trim plates.
Attach trim plates N2759-24101 using four decorative fasteners 
0570-1366.
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Specifications Terms and Conditions (N4391A)

Definitions

Generally, all specifications are valid at the stated operating and 
measurement conditions and settings, with uninterrupted line voltage.

Specifications (Guaranteed)

Describes warranted product performance that is valid under the specified 
conditions.

Specifications include guard bands to account for the expected statistical 
performance distribution, measurement uncertainties changes in 
performance due to environmental changes and aging of components.

Typical Values (Characteristics)

Characteristics describe the product performance that is usually met but 
not guaranteed. Typical values are based on data from a representative set 
of instruments.

General Characteristics

Give additional information for using the instrument. These are general 
descriptive terms that do not imply a level of performance.

Digital demodulation measurement conditions

• Data acquisition: DSO and DSA Z series Oscilloscopes (N4391A)

• Office environment 25 ºC ± 5 ºC

• Signal power (N4391A) +7.5 dBm at signal input port

• Vector analyzer I-Q bandwidth set to 12.5 GHz

• QPSK demodulation

• 2.5 GHz beat frequency

• 10 Gbaud symbol rate

• SinglePolKFPhaseTrack algorithm Q = 1E-4

• 500 symbols per analysis record
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N4391A Specifications

The following specifications are typical, if not stated otherwise.

Optical modulation analyzer

Maximum detectable baud rate Up to 62 Gbaud

Sample rate 4 x 80 Gs/s

Number of polarization alignment algorithms 6

Digital demodulation uncertainty

Error vector magnitude noise floor 1.8 %rms

Amplitude error 1.1 %rms

Phase error 0.9º

Quadrature error 0.05º

Gain imbalance between I and Q < 0.007 dB

Image suppression > 35 dB

S/N > 60 dB

Sensitivity −20 dBm

Supported modulation formats

BPSK, 8BPSK, VSB -8, -16, FSK 2-, 4-, 8, 16 level EDGE

Offset QPSK, QPSK, Pi/4 QPSK DQPSK, D8PSK DVB QAM 16, 32, 64, 128, 256

QAM 16-, 32-, 64-, 128-, 256-, 512-, 1028- MSK type 1, type 2 CPM (FM) APSK 16/32 (12/4 QAM)

StarQAM -16, -32 Generic APSK decoder
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Coherent reference receiver

Optical DUT input

Optical input wavelength range 1528 mn to 1630 nm

Maximum input power +14 dBm

Maximum input power, damage level +20 dBm

Receiver polarization extinction ratio > 40 dB

Average input power monitor accuracy ±0.5 dB

Optical local oscillator output

Optical CW output power > +14 dBm

Wavelength 1528 nm to 1630 nm

External local oscillator input

Optical input wavelength range 1528 nm to 1630 nm

External local oscillator input power range 0 dBm to +14 dBm

Maximum input peak power (damage level) +20 dBm

Small signal gain, external laser input to local oscillator output (−20 dBm LO 
input power)

28 dB @ 1550 nm

Saturation output power @ −3 dB compression 15 dBm

Other

Electrical bandwidth Standard version 43 GHz, 37 GHz guaranteed

Light version (software 
upgradable)

22 GHz

Optical phase angle of I-Q mixer after correction (1529 nm to 1630 nm) 90º ±0.5º

Relative skew after correction (1529 nm to 1630 nm) ±1 ps
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EVM %rms is dependent upon average optical input power.

This graph above shows the %rms Error Vector Magnitude (EVM) 
normalized to the highest error vector within an analysis record of 500 
symbols as a function of signal input power. The EVM %rms level at higher 
power levels results from the instrument noise level. The increase at lower 
signal power levels is a result of decreasing signal to noise ratio. The fitted 
model reveals the EVM %rms noise floor in the offset term.
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Data acquisition (for Keysight 90000-X and 90000-Q series oscilloscopes)

Sample rate Up to 80 GSa/s on each channel

Data acquisition bandwidth 16/20/25/32 GHz upgradable

Jitter between channels Typ 700 fs

Noise 0.6 mV rms @ 10 mV range, 32 GHz bw

ADC resolution 8 bit/16 bit (interpolated)

Sample memory per channel Up to 2 Gs/channel

Local oscillator (guaranteed specification if not mentioned otherwise)

Option -500, 501 Option -510

Wavelength range Option 500 1527.6 to 1565.5 nm (196.25 to 191.50 THz) 1528 nm to 1630 nm

Option 501 1570.0 to 1608.8 nm (190.95 to 186.35 THz)

Minimum wavelength step 25 GHz 1 pm

Tuning time/sweep speed < 30 s 50 nm/s

Absolute wavelength accuracy ±22 pm ±20 pm, ±5 pm typical

Stability (short term) 100 kHz 100 kHz

Sidemode suppression ratio 50 dB typical ≥ 50 dB

RIN −145 dB/Hz (10 MHz to 40 GHz) typical −145 dB/Hz (0.1 to 6 GHz) typical

High resolution spectrometer

Maximum frequency span 31.25/40/50/62.5 GHz

LO wavelength range 1528 nm to 1630 nm

Image suppression > 35 dB

Number of FFT points 409601

Minimum RBW (record length 10^6 points) 4 kHz

Signal to noise ratio 60 dB @ 7.5 dBm signal input power

Frequency accuracy Absolute ±5 pm
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 The graph above shows the relative power uncertainty of the N4391A.
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N4391A General Characteristics

Dimensions (Wide x Tall x Deep)

Z series based N4391A system 51 cm (20.0”) x 47 cm (18.5”) x 52 cm (20.5”)

DSOX9xx04Z oscilloscope 51 cm (20.0”) x 34 cm (13.3”) x 49 cm (19.4”)

Optical receiver 48 cm (18.9”) x 13 cm (5.2”) x 49 cm (19.4”)

Packaged d imensions

DSOX9xx04Z 69 cm x 48 cm x 81 cm

Optical receiver 65 cm x 49 cm x 79 cm

Weight

Product net weight DSOZ xxxA 32 kg (71 lbs)

DSOZxxxA N4391A system 48 kg (106 lbs)

Packaged product 60 kg (132 lbs)

Power requirements

100 to 240 V~, 50 to 60 Hz

Optical receiver Max. 300 VA

Storage temperature range

−40º C to +70º C

Operating temperature range

+5º C to +35º C

Humidity

15% to 80% relative humidity, non-condensing

Al titude (operating)

0 ... 2000 m

Recommended re-calibration period

1 year

Coherent receiver optical input
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DUT input +20 dBm max

9 μm single-mode angled

81000 connector interfaces

LO input +20 dBm

9 μm PMF angled

81000 connector interfaces

Coherent receiver optical input

LO output +20 dBm max

9 μm PMF angled

81000 connector interfaces

Laser safety information

All laser sources listed above are classified as Class 1M according to IEC 
60825-1/2007.
All laser sources comply with 21 CFR 1040.10 except for deviations pursuant to 
Laser Notice No. 50, dated 2007-06-24.
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Specifications Terms and Conditions (N4392A)

Definitions

Generally, all specifications are valid at the stated operating and 
measurement conditions and settings, with uninterrupted line voltage. 

Specifications (Guaranteed)

Describes warranted product performance that is valid under the specified 
conditions.

Specifications include guard bands to account for the expected statistical 
performance distribution, measurement uncertainties changes in 
performance due to environmental changes and aging of components.

Typical Values (Characteristics)

Characteristics describe the product performance that is usually met but 
not guaranteed. Typical values are based on data from a representative set 
of instruments.

General Characteristics

Give additional information for using the instrument. These are general 
descriptive terms that do not imply a level of performance.

Reference Conditions

Office environment 25 °C ± 5

Reference Conditions for Error Vector Magnitude Noise Floor

Optical continuous wave signal at optical input port

• Signal power > 0 dBm

• Optical frequency is offset by 2.5 GHz from local oscillator frequency

Span setting

• Vector analyzer I-Q spectrum span set to 12.5 GHz

• Digital demodulator settings

• QPSK demodulation
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• 10 Gbaud symbol rate

• SinglePolKFPhaseTrack algorithm Q=1E-4

• 500 symbols per analysis record
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N4392A Specifications

The following specifications are typical, if not stated otherwise.

Optical modulation analyzer (Option 300)

Specification Typical Value

Maximum detectable baud rate 46 Gbaud

Maximum detectable bit rate for DP-QPSK 184 Gbit/s

Maximum detectable bit rate for DP-16 QAM 368 Gbit/s

Sample rate 63 Gs/s

Maximum record length per channel 16000 samples

ADC resolution 8 bit

Optical receiver frequency range 31 GHz

Optical receiver signal bandwidth > 22 GHz > 23 GHz

Optical wavelength range (Option 100) 1527.6 to 1565.5 nm (196.25 to 191.50 THz)

Optical wavelength range (Option 110) 1570.01 to 1608.76 nm (190.95 to 186.35 THz)

Absolute wavelength accuracy (with internal local 
oscillator) 

± 3 pm ± 2 pm 

Average input power monitor accuracy ±0.5 dB

Optical phase angle of I-Q mixer after correction (1527.6 to 
1565.5 nm)

90º ±1.0º

Relative skew after correction (1527.6 to 1565.5 nm)* ±1 ps

Image suppression† > 30 dB

Error vector magnitude noise floor < 2.4% EVM rms

Sensitivity −22 dBm

High resolution spectrum analyzer (Option 300)

Maximum optical frequency span > 49 GHz

Minimum RBW (record length 16 k points 4 MHz

Absolute frequency accuracy ± 3 pm ± 2 pm 

Differential RF d igitizer inputs (Option 310)

RF digitizer inputs 4 channels, differential inputs

Sample rate 63 GS/s 

Maximum record length per channel 16000 samples
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ADC resolution 8 bit

Digitizer frequency range 31 GHz

Input bandwidth > 21 GHz > 23 GHz

Skew between different input channels (I and Q) ± 2 ps

Skew between differential inputs (p and n) ± 2 ps

Input amplitude range (single ended) 0.9 Vpp

Impedance 50 Ohm

Damage level 3 V DC, +3 dBm RF

Connector type 2.92 mm (m)

Local oscillator input (Option 320)

Optical wavelength range (Option 100) 1527.6 to 1565.5 nm (196.25 to 191.50 THz)

Optical wavelength range (Option 110) 1570.01 to 1608.76 nm (190.95 to 186.35 THz)

External local oscillator input power range –3 to + 16 dBm

Maximum input peak power (damage level) + 20 dBm

Basic modulation formats (Options 300, 310)

BPSK, QPSK, DQPSK, QAM16

DP-BPSK, DP-DPSK, DP-QPSK, DP-DQPSK, DP-16QAM

Additional modulation formats Option 410 (single and dual polarization)

Generic APSK decoder, 8BPSK, VSB -8, -16, FSK 2-, 4-, 8, 16 level, EDGE, D8PSK

DVB 16, 32, 64, 128, 256, QAM, 32, 64, 128, 256, 512, 1028

MSK type 1, type 2 CPM (FM), APSK 16/32 (12/4 QAM), StarQAM -16, -32

*  < 17 GHz, 2 ps < 23 GHz.

†  Reference conditions.

  @ EVM = 32.5 % for 32 GBaud DP-QPSK corresponding to raw BER=1E-3, boost mode off.

Optical modulation analyzer (Option 300)
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N4392A General Characteristics

Display

Display type 15 inch color XGA TFT-LCD

Resolution 1024 pixels horizontally x 768 pixels vertically

Dimensions (Height x Wid th x Depth)

Product dimensions 33 x 43 x 23 cm (12.9 x 16.8 x 9 in)

Weight

Product net weight 13 kg (28.7 lbs)

Power requirements

Voltage levels 100 to 240 V, AC

Net frequency range 50 to 60 Hz

Power requirement 375 VA

Storage temperature range

−40º C to +70º C

Operating temperature range

+5º C to +35º C

Humidity

15% to 80% relative humidity, non-condensing

Altitude (operating)

0 ... 2000 m

Optical connectors

Signal input 9 μm single-mode angled

(Option 300) 81000 connector interfaces

LO input 9 μm PMF angled

(Option 320 only) 81000 connector interfaces

LO output 9 μm PMF angled

(Option, 320, 310 with 100/110 81000 connector interfaces

Auxiliary source 9 μm PMF angled

(Option, 320, 310 with 100/110 81000 connector interfaces
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Technical Specifications 5

 

Laser safety information

All laser sources listed above are classified as Class 1M according to IEC 
60825-1/2007.
All laser sources comply with 21 CFR 1040.10 except for deviations pursuant 
to Laser Notice No. 50, dated 2007-06-24.
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5 Technical Specifications
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6 Regulatory Information
 

Declaration of Conformity
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Regulatory Information 6
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6 Regulatory Information
 

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German 
Regulation on Noise Declaration for Machines (Lärmangabe nach der 
Maschinenlärmverordnung–3.GSGV Deutschland).

Compliance with Canadian EMC Requirements

This ISM device complies with Canadian ICES- 001.
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

Acoustic Noise Emission Geräuschemission

LpA < 70 dB LpA < 70 dB

Operator position am Arbeitsplatz

Normal operation normaler Betrieb

Per ISO 7779/ISO 3744 nach ISO 7779/ISO 3744
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